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Objectives 

 Learn to apply quick style formatting. 
 Learn  to apply style using shortcut keys. 
 Learn how to create a new style. 
 Learn how to repeat a format using Format Painter. 
 Learn how to apply Themes to your document. 
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ll formatting in Microsoft Word is controlled by 

styles. A style is a set of formatting instructions. Word 

applies the formatting instructions when you apply a 

style. Microsoft Word comes with dozens of built-in styles. 

You can also create your own Word styles.  

 

The general idea is that you modify a style to suit your 

particular formatting needs, and apply the style to your text.  

 

There are several kinds of styles in Word. The most 

commonly used are paragraph styles and character styles. Not 

surprisingly, paragraph styles are used to format a paragraph. 

And character styles are used to format characters within a 

paragraph.  

Style Formatting Word 2007 
In Word 2007 you can choose a ready-made quick style, or you can apply the styles 

you've created and saved previously. You can change the look of the styles you are 

using by choosing a different style set. You can also change the Theme which 

drastically alters the look of the whole document by changing color schemes, the 

appearance of objects and even fonts. Hovering over a style temporarily applies a Live 

Preview of the style, which is removed when the mouse points away. This allows users 

to see a preview of how the style would affect the appearance of the object, without 

actually applying it. 

One of the new changes in Word 2007 is, of course, the new styles and the most 

obvious part of this is the new default font called Calibri. Calibri is a clean and 

attractive font and its default size for new Word documents is 11 points. Word 2007 

adds an extra 10 points of space after each paragraph so you only need to press Enter 

once. Other changes affect the way styles like Heading1, Heading2 are formatted. 

Display Style Pane 

1. Click the Office button, and then click Word Option. 

2. Select Advanced, and scroll down to Display. 

3. Enter 1” for Style area pane width. 

A 
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Or 

View tab>Document View>Outline 

 

 

 

  

The Style Group - Provides access to a list of styles that 

can be applied to your current document 

 

Apply Quick Style 

To apply a Quick Style using the Style Group.    

Click on the More arrow to select all of the 

new Quick Style. 

 
 

The follow list of style will appear:  
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Display Style List Box 

In the Style group, click the Styles Dialog launch button   Leave this box open 

when using style formatting.   You can easily manage all of your documents style from 

this box. 
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Applying Styles 

You can apply a paragraph or a character style by selecting one from the Styles group. 

1. Select the text you want to apply the style to 

2. From the Home tab, in the Styles group, click the More button. 

NOTES: A gallery of styles appears. 

3. When the cursor hovers over a style, a preview of the style 

appears in the selected text. 

4. Select the style you want to apply 

5. The style is applied to the selected text. 

 

Style Shortcut Keys 

Do any one of the following to apply a style to your selected text. Use which ever 

method suits you best.  

Type Ctrl-Shift-S 

That takes you to the Apply Styles pane. Here you can choose from a drop down list of 

styles or use the keyboard alone to apply a style. 

 
or 

Apply Style with Shortcut Keys 

 

1. Apply Heading 1 style: Alt-Ctrl-1  

2. Apply Heading 2 style: Alt-Ctrl-2  
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3. Apply Heading 3 style: Alt-Ctrl-3  

4. Apply Normal style: Ctrl-Shift-n  

Promote and Demote Heading Style 

Promote a heading paragraph to the next-highest level (for example, Heading 2 to 

Heading 1): Shift-Alt-Left arrow  

Demote a heading paragraph to the next-lowest level (for example, Heading 1 to 

Heading 2): Shift-Alt-Right arrow  

Clear all Formatting 

 

1. Click the Styles arrow. 

2. Select the text you want to remove the formatting from 

3. In the Styles task pane, select Clear All. 

4. All formatting is removed from the selected text. 

How styles in Microsoft Word cascade 

If a style is based on another style, it takes on the formatting of its parent, unless you 

specify otherwise.  Microsoft Word uses styles to control formatting. Word comes with 

dozens of built-in styles. You can modify every one of the built-in styles. You can also 

create your own styles. 

There are several kinds of styles in Word. The most commonly used are paragraph 

styles and character styles. 

The term "cascading styles" normally refers to the cascading style sheets used in html 

documents to create web pages. The principles of Word's styles are much the same, so it 

seems appropriate to use the same term to apply to a very similar concept. 

A style can be based on another style 

A style can be based on another style, or it can be based on "No style". 

You can get a print-out of the full descriptions for all the styles in your document.  

And styles can be based on styles based on styles, up to 9 levels deep. So a style may 

have a parent, and a grand-parent; and it may have one or more children. 

To see, or change, the base of a style, modify the style. 
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Styles inherit the properties of their parents 

A style inherits all the attributes of its parent, except to the extent that you specify 

otherwise. 

For example, if a parent style is Times New Roman 12pt blue, then its child will be 

Times New Roman 12pt blue, unless another font, size or color has been specified. 

Cascading formatting and headings 

Base heading styles on the previous heading level style 

It's a good idea to set up your heading styles so that Heading 2 is based on Heading 1, 

Heading 3 is based on Heading 2, and so on. This allows you to make radical changes to 

your document very easily. 

If you're going to do this, you need to base Heading 1 on "No Style" because Word has 

9 levels of Headings, and only accepts 9 generations of styles. I actually like this 

"feature", because it completely separates the formatting of the headings and the body 

text. So I can make a change to all the headings easily without affecting any body text, 

and vice versa. 

 

 

 

 

 

 

 

 

 

 

Style Set 

A Style Set is a set of formats consisting of fonts, font colors, font sizes, and paragraph 

formats. Word 2007 has predesigned built-in style sets that contain styles for titles, 

subtitles, quotes, headings, lists and more.  

 

1. Click Change Styles in the Styles group.  

2. Click Style Set. A drop-down menu appears. You can choose 

from any of the styles listed on the menu.  

Heading 1 

Heading 2 

Heading 3 Style based on 

 Heading 1 

Style based on 

 Heading 2 
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3. Word 2007 reformats all of the paragraphs into the selected 

style set by applying the Normal format to each paragraph. 

 
 

Default Style Set 

Once you’ve modified all the styles and you’re happy with it, simply click the “Change 

Styles” button and select “Set as Default”. From now on each new document you create 

will have all those styles available by default. 



 Lesson Five: Using Style & Themes  

 

Word 2007  5.8 1/5/09 

 

Themes 

A theme is a set of formatting choices that can be applied to an entire document and 

includes theme colors, fonts, and effects.  The purpose of a theme is to allow the 

changing of fonts and colors in a consistent way across a document without having to 

redefine the individual styles. 

 
 

 

The Theme group is on the Page Layout tab of the 

ribbon. When you click the main Themes icon, a display 

appears that shows you all the built-in themes you have 

available. What's even cooler is that a wonderful new 

feature in Word 2007 will cause the document's display to 

change simply by moving your mouse over any of the 

themes displayed. This Live Preview is great because you 

don't have to select an item to see how it will change your 

document. Just move your mouse around the choices and 

your document temporarily displays the potential 

changes. When you see the one you like, click to select it.  

You can customize a theme by changing the colors, fonts and effects to be applied. 

Each setting is available in the drop down lists next to the "Themes" icon on the "Page 

Layout" ribbon. Once you have customized the theme and would like to save the 

settings as a new theme, select "Save Current Theme" from the "Themes" dialog. Give 

the theme a name and save it in the default location by selecting "Save." 

Live Preview 

Take advantage of the Live Preview when changing style.  This feature enables you to 

preview your changes before you apply them, so experiment with the changes. To 

preview different Themes in your document, select the Page Layout tab and click 

Themes. The Themes gallery opens, displaying a number of different Theme choices. 
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Exercise 

Using Style 

1. Open file: Exercise 6 – Using Style.doc 

2. Open the Style dialog in the Style Group. 

3. Use style formatting to modify the style. 

4. Change “Gino’s Pizza” to Heading 1. 

5. Modify Heading 2 font. 

6. Add a colorful border to Heading 1 style. 

 

Cascading Style 

1. Open file: Exercise 7 – Cascading Style.doc. 

2. Change the border and shading color of Heading 1. 

Look and see what happens. 

Heading 1 

Heading 2 

Heading 3 Style based on 

 Heading 1 

Style based on 

 Heading 2 
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Modify a Style 

 

When you modify a style, all the text that has been formatted with that style is updated 

to reflect the changes you have made. Suppose that you finish a 35-page report with 

many subheadings formatted with a style called Subhead, which includes 18-point, 

bold, Arial, and centered text. Now you decide that the subheadings should be smaller 

and justified left. Simply modify the Subhead style to reflect the new formatting and all 

the text within the Subhead style will change. 

 

Each time you begin a new document based on the Normal template, Word uses the 

Normal style to determine the font, font size, line spacing, and other formats. If you find 

that you are always changing the font, the point size, or some other aspect of the 

Normal style, you can change its default format settings. If you are working in a lab, 

Word may not permanently update the Normal template. 

 

1. Right-click the style you want to modify, and then click Modify 

or click on the  next to the style. 

2. Select any options you want. 

3. To see more options, click Format, and then click the attribute 

— such as Font or Numbering — you want to change. 

 

Click OK after you've changed each attribute, and then repeat for any additional 

attributes you want to change. 

 

Create a New Style 

 

If you want to create styles before you use them rather than creating them by example, 

use the New Style dialog box. Using this feature, you name a style, define its formatting 

characteristics, and select options, such as whether to base the style on another style, 

whether to follow it with another style, and whether to add the style to the current 
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template. You can also import and export styles to and from other documents and 

templates. 

 
When you create a style by using the New Style dialog box, you have the option to 

apply that style to the currently selected paragraph, or simply add it to the list of styles 

you created for your document or your template. 

 

 
 

1. Click the New Style   button at the bottom of the style 

pane. 

2. In the Name box, type a name for the style (style: A 

combination of formatting characteristics, such as font, font 

size, and indentation, that you name and store as a set. When 

New Style Button 



 Lesson Five: Using Style & Themes  

 

Word 2007  5.12 1/5/09 

you apply a style, all of the formatting instructions in that style 

are applied at one time.). 

3.  In the Style type box, click Paragraph, Character, Table, or 

List to specify the kind of style you are creating. 

4. Select the options that you want, or click Format to see more 

option 

 

Rename a Style 

Renaming styles does not affect your text, but it changes the style name throughout 

your document. . You cannot rename a built-in style, but you can assign a keyboard 

shortcut to it to make it easier to access. 

 

1. Access the style pane 

2. To rename a style, just modify the style.  Replace the current 

name in the Name field. 

Delete Style 

 

1. Display the style pane. 

2. Right-click the style you want to delete, and then click Delete. 

To delete multiply style: 

1. Click the Manage Styles button manage styles. A dialog box 

will open. 

2. Select the style you want to delete from the list. 

3. Select the style and click delete. 
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Note: If you delete a paragraph style (paragraph style: A combination of character- and 

paragraph-formatting characteristics that are named and stored as a set. You can select a 

paragraph and use the style to apply all of the formatting characteristics to the paragraph 

at one time.) that you created, Microsoft Word applies the Normal style (Normal style: 

The default paragraph style used in documents based on the Normal template 

(Normal.dot).) to all paragraphs that were formatted with that style and removes the 

style definition from the task pane. 

 

 

Copy Style with Format Painter 

Simply select the text, double click the Format Painter on the Home tab (it then 

remains active until you press Esc or click the button again). Note the paintbrush that 

stalks your cursor as you move it. When you select your target text, the copied 

formatting is applied as soon as you release the mouse button. 
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Using Format Painter saves you that time and duplicated effort. Instead of having to 

manually apply the font, font effects, centered paragraph alignment, and other 

formatting to each new section heading, you can quickly copy all of the formatting 

attributes by using one toolbar button. 

To copy formatting 

 

1. To copy both paragraph attributes (such as alignment, 

indentation, and so on) and character attributes (such as font 

and font effects), select the text whose formatting you want 

to copy plus the paragraph mark that follows the text. 

2.   To copy only character attributes, select the text without 

selecting the paragraph mark. 

3. On the Standard toolbar, click Format Painter. 

4. Select the text you want to apply the formatting to. 

5. The text takes on the new formatting. 

 

If you want to apply the same formatting to more than one item, select the formatting 

you want, double-click Format Painter, and then select each word, phrase, or paragraph 

you want to apply formatting to. When you're finished, press ESC. 

Templates 

Templates are pre-set documents that allow you to "fill-in" information. This is useful 

when you may want to create the same type of document over and over. 

 

Word '2003 provides several templates for creating professional documents for 

memorandums, faxes, resumes, newsletters, and more.  To use a template, click on File, 

New. 
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QUIZ 

 

1. What's the advantage of using a style to format a document? 

a. A style gives you access to the Font dialog box, which has many 

design choices. 

b. A style's purpose is to apply many types of formatting at once. 

 

2. What kind of style is a heading style? 

a. A paragraph style. 

b. A character style. 

c. The Normal paragraph style. 

 

3. In the Styles and Formatting task pane, what's a quick way to see the 

attributes of a style? 

a. Click the arrow on the style. 

b. Click the style. 

c. Point to the style. 

 

4. There's a way to select every instance of a style in your document by 

clicking a single button. 

a. True. 

b. False. 

 

5. What's the quickest way to modify a style? 

a. Select text and format it the way you want it, and then use the Update 

to Match Selection command in the style list in the task pane. 

b. Display the style's menu in the task pane, click Modify, select the 

various formatting options you want in the Modify Style dialog 

box, and then click OK 

 


